CallPilot™
Release 2.5
Desktop Messaging User Guide
for Internet Clients
Updates to the
Desktop Messaging User Guides

Internet Clients

Page 7 Call the sender of a message
Call the sender of a message is not supported.

Page 7 Access web-based My CallPilot to view user information and change your feature settings
My CallPilot is not supported.

Page 8 About this guide
The Internet mail clients that are supported are:

- Microsoft Outlook 2000 (Internet mail mode)
- Microsoft Outlook 2002 (XP) (Internet mail mode)
- Microsoft Outlook 2003 (Internet mail mode)
- Microsoft Outlook Express - 5.x and 6.x
- Netscape Messenger (Netscape Communicator) - 6.2x
- Netscape Mail - 7.0x
- Qualcomm Eudora Pro - 6.1.2

Citrix (Terminal server) functionality is supported.

Page 11 CallPilot Player
The Call the sender button is not available.

Page 11 To select your telephone or computer to play voice messages
If your telephone is call forwarded to voicemail, cancel this feature before you access your messages from CallPilot Player.

Page 29 Linking to My CallPilot
Linking to My CallPilot is not supported.

About forwarding Desktop Messaging messages
Do not use the right-click menu to forward a Desktop Messaging message. To forward a message, either:

- open the message and forward it from the CallPilot window
- for Outlook, select the message in the Outlook Inbox and forward it from the Outlook toolbar.
Outlook, Lotus Notes, GroupWise

Page 7 Call the sender of a message
Call the sender of a message is not supported.

Page 7 Access web-based My CallPilot to view user information and change your feature settings
My CallPilot is not supported.

Page 8 About this guide
The groupware e-mail clients that are supported are:
- Lotus Notes - 5.x and 6.x
- GroupWise - 6.x
- Microsoft Outlook 2000, 2002 (XP), and 2003
Citrix (Terminal server) functionality is supported.

Page 11 (Page 12 Lotus Notes) CallPilot Player
The Call the sender button is not available.

Page 11 (Page 12 Lotus Notes) To play a message from your telephone
If your telephone is call forwarded to voicemail, cancel this feature before you access your messages from CallPilot Player.

Page 14 (Page 15 Lotus Notes) Composing fax and text messages
On the Compose Fax dialog box you can use the Subject field to add additional information to the fax cover page (for example, the name of the recipient) when you send a fax directly to a fax machine. The maximum length you can enter in the Subject field is 80 characters.

Page 27 (Page 28 Lotus Notes) Calling the sender of a message
Calling the sender of a message is not supported.

Page 28 (Page 29 Lotus Notes) Setting message options
Delivery Receipt is not supported.

Page 31 (Page 34 Lotus Notes and Microsoft Outlook) Personal distribution lists
Personal Distribution lists are not supported.

Page 37 (Page 40 Lotus Notes and Page 39 Microsoft Outlook) Linking to My CallPilot
Linking to My CallPilot is not supported.
CallPilot Desktop Messaging User Guide
for Internet Clients

Product releases: 2.5
Document release: Standard 2.0
Date: April 2004

Copyright © 2003, Nortel Networks Nortel Networks, All Rights Reserved

Information is subject to change without notice. Nortel Networks reserves the right to make changes in design or components as progress in engineering and manufacturing may warrant.

The process of transmitting data and call messaging between CallPilot and its servers, switches or system is proprietary to Nortel Networks. Any other use of the data and the transmission process is a violation of the user license unless specifically authorized in writing by Nortel Networks prior to such use. Violations of the license by alternative usage of any portion of this process or the related hardware constitutes grounds for an immediate termination of the license and Nortel Networks reserves the right to seek all allowable remedies for such breach.

Nortel Networks and third-party trademarks appear on the following pages:
PROMARK and RHOBOT are trademarks of DMI Promark, Inc.
QUICKTIME is a trademark of Apple Computer, Inc.
RADISYS is a trademark of Radisys Corporation.
ROLM is a trademark of Siemens ROLM Communications Inc.
SLR4, SLR5, and TANDBERG are trademarks of Tandberg Data ASA.
SONY is a trademark of Sony Corporation.
SYBASE is a trademark of Sybase, Inc.
TEAC is a trademark of TEAC Corporation.
UNIX is a trademark of X/Open Company Limited.
US ROBOTICS, the US ROBOTICS logo, and SPORTSTER are trademarks of US Robotics.
WINAMP is a trademark of Nullsoft, Inc.
WINRUNNER is a trademark of Mercury Interactive Corporation.
WINZIP is a trademark of Nico Mark Computing, Inc.
## Contents

- Welcome to CallPilot ........................................ 7
- Getting started .................................................. 8
- Logging in to CallPilot .......................................... 9
- Working with your CallPilot messages ...................... 10
- Playing voice messages ....................................... 11
- Viewing fax messages .......................................... 12
- Composing voice messages ................................... 13
- Composing fax and text messages ......................... 14
- Creating and sending fax batch messages ............... 15
- Using fax cover pages ......................................... 22
- Addressing messages .......................................... 25
- Changing your mailbox settings ............................. 27
- Changing audio settings ...................................... 28
- Using My CallPilot .............................................. 29
- Document information .......................................... 30
Welcome to CallPilot

CallPilot from Nortel Networks is an advanced business communications system that offers exceptional flexibility for managing your messaging needs.

You can work with CallPilot from your telephone or your computer. Desktop messaging gives you access to your CallPilot mailbox through your Internet e-mail. Here are some of the many ways you can use CallPilot with your e-mail:

- Listen to voice messages.
- View and print fax messages.
- Record and send voice messages.
- Create and send fax messages, including batch faxes.
- Forward and reply to voice and fax messages.
- Call the sender of a message.
- Access web-based My CallPilot to view user information and change your feature settings.

Some features mentioned in this guide may not be available for your CallPilot mailbox. For details, refer to the Feature availability topic in the CallPilot Player online Help, or ask your administrator.
Getting started

About this guide

This user guide is an overview of how to use CallPilot with your Internet e-mail. The instructions and screen images shown in this guide provide general information for using CallPilot with your e-mail. Specific details may vary for each e-mail application. For further assistance in using CallPilot, refer to the online Help in the CallPilot Player.

What you need

Before you start to use CallPilot, your administrator ensures that your e-mail account is correctly configured for CallPilot. Your computer must be set up according to the following requirements:

- CallPilot Player to play and record voice messages
- Nortel Fax Driver to create faxes
- Outlook Express 5.x and 6.x, Outlook 98 and 2000 SR2 (in Internet Mail mode), Microsoft Outlook 2002 SR2 (for IMAP accounts), Netscape Messenger 6.2 and later, or Qualcomm Eudora Pro Email 5.x
- Windows 98 SE, Windows 2000 Professional, or Windows XP
- Monitor with 256-color 800 x 600 capability
- 15 Mbytes of free disk space to install software
- Sound card and speakers for playing voice messages on your computer
- A microphone connected to your computer, or a telephone situated near your computer, for recording voice messages
- A LAN (Ethernet), ISDN, ADSL, or dial-up modem connection to the CallPilot server for accessing CallPilot messages
- Internet Explorer 5.x and 6.x; or Netscape 6.2x and above, to access My CallPilot
Logging in to CallPilot

When you log in to your e-mail, you can log in to CallPilot at the same time.

1. Open your Internet e-mail. You see a CallPilot Logon/Password dialog box similar to the example shown.
2. If required, type your User Name-Mailbox Number.
3. In Password, type your CallPilot password.
4. Click OK.

Note: If the Remember password option is available, do not leave the box checked on a shared computer.

To change your password the first time you log in

Your administrator may give you a password and tell you to change it before you log in through your Internet e-mail. To do this, log in to CallPilot from the telephone or log in to My CallPilot on your computer.

After your first login, you can change your password from the CallPilot Player. See To change your CallPilot password, page 29.

To log out

When you exit your e-mail application, you automatically log out of CallPilot.

Remote login

You can log in to your mailbox from any computer that has CallPilot configured in the same way as your office computer. For example, you can use a computer set up for guest access, or your home computer with a dial-up connection.
Working with your CallPilot messages

When you open your e-mail with CallPilot installed, your CallPilot messages appear in your Inbox. You can open, move, copy, delete, forward, and reply to CallPilot messages, and compose new CallPilot messages, in the same way as your e-mail messages.

Your CallPilot messages

To open a message

To open a CallPilot message, double-click anywhere on the message line, then double-click the voice or fax icon to open the attachment. See Playing voice messages, page 11, and Viewing fax messages, page 12.

To delete a message

Delete CallPilot messages the same way as your e-mail messages. You can delete a CallPilot message in your Inbox or in an open message.
Playing voice messages

To select your telephone or computer to play voice messages

You can choose to play your voice messages from your telephone or your computer. To change the setting, or to change the telephone number that CallPilot dials, see Changing audio settings, page 30. You can also click the Telephone or Computer icon on the CallPilot Player to change the setting.

To play a voice message

1. Double-click the message in your Inbox, then double-click the Voice icon in the open message. The CallPilot Player appears.

2. Listen to the message, using the buttons on the CallPilot Player to play, stop, and re-play the message, and to go backward and forward. You can adjust the volume and speed if you are using your computer for playback. You can call the sender from your telephone.

3. You can print, delete, save, forward, and reply the same as an e-mail.

4. When you are finished, hang up the telephone if you used it, close the CallPilot Player, and close the open message.

To save a voice message as a file to use later

1. In an open message, right-click a voice icon, then click Save as... .

2. In the File name box, type a name for the file, select a folder to keep the file in, then click Save.
Viewing fax messages

In order to receive faxes, your CallPilot administrator must enable fax capability for your mailbox.

To view a fax message

1. Double-click a fax message in your Inbox, then double-click the Fax icon.
2. While viewing the fax, you can enlarge or reduce the image, rotate or move it, print it, delete it, save it, forward it, and reply to it.
3. When you are finished, close the message.
Composing voice messages

To compose and send a CallPilot voice message, you record a message and save it as a file, then attach the file to a new message and send it. You can also save the file to send later.

To record a voice message and save it as a file

1. Open the CallPilot Player, and click the red Record button.
2. Record your message.
   - If you are recording from the computer, record your message into the microphone. Click Stop to end the recording. Click Play to review it. To add to the recording, click Record, speak again, then click Stop.
   - If you are recording from the telephone, answer when it rings. At the tone, record your message. Click Stop to end the recording. Click Play to review it. Hang up the telephone.
3. On the File menu, click Save As..., and type a name for the file. Save it as a .vbk file. Click Save.

To send a voice message

1. Open a new message form.
2. Add a voice file as an attachment, or type text.
3. Address and send the message the same way as an e-mail.
Composing fax and text messages

To create a fax, your CallPilot mailbox must have fax capability, and your computer must have Desktop Messaging installed. CallPilot recipients of your fax must also have fax capability to view the fax on their computer. E-mail recipients do not require specific fax capability. If your recipients access their messages from their telephone, they can view the fax only by printing it. You can also send your fax to a fax machine.

To create and save a fax file

1. Open the document that you want to fax. It must be 8.5 in. (21.5 cm) wide or less.
2. On the File menu, click Print.
3. From the list of printers, select Nortel Fax, then click Print or OK.
4. In the Compose Fax dialog box, click Save As.
5. Type a name for the file and browse to select a folder to save it in. Save the file as a .tif file. Click Save.
6. In Compose Fax, click Exit.

For information on the use of cover pages in your fax, refer to the Using fax cover pages section on page 24.
To send a single fax or text message

1. In a new message form, add a fax file as an attachment, or type text. Fax files must be in .tif format.

2. Address and send the message the same way as an e-mail.
Creating and sending fax batch messages

To send customized CallPilot fax messages to multiple recipients you can use Microsoft Word's Mail Merge and send your print job to the Nortel Fax Batch printer. You must be familiar with Microsoft Word's Mail Merge functionality to use this feature. Consult your MS Word documentation. Note that the CallPilot Fax Batch feature is only available to CallPilot Desktop and Web users who install the Nortel Fax Batch Print Driver.

To use Mail Merge with CallPilot, you will need your main document (the file you want to send to your recipients) and a data source document which contains recipient information such as names and fax numbers.

Your Callpilot Desktop Messaging installation includes an example Microsoft Word data source named Data.doc and an example Microsoft Word main document named Sample.doc. Each of these are examined below to explain the batch fax procedure.

Accessing and modifying the example Data source document

The Data.doc file consists of a Microsoft Word table. It is organized in columns, with one row for each recipient. The following column headers exist in the sample: ToFax, ToName, DelReceipt, DelType, ToCompany, and ToPhone. These column headers can be modified, deleted and new columns can be added. The column header names serve as tags that can be inserted into the main document to customize the fax for each recipient or to direct CallPilot on how to handle the fax.
1. Go to \Program Files\Nortel Networks\CallPilot\nda directory and open the Data.doc file.

2. Add new columns or subtract existing ones, as required. For new columns, choose a meaningful column header name.

3. Add the required data under each column header. The data source can be created by any means available to populate a Microsoft Word table, including importing information from existing files.

   If you edit the recipient list using the Mail Merge utility (i.e. click on Edit in the Data source section of the MS Mail Merge Helper), the Data Form window opens and lists all the entries from the data source table. You can add, delete, modify and search for records in this window. Any column headers that you added or modified in the data source file will automatically appear in this window. Note that the **ToFax** field is the only mandatory field for CallPilot.

   The following parameters and characters are supported in the **ToFax** field:
   - Maximum supported length for the fax phone number is 120 characters.
   - Numbers 0 through 9 are supported.
   - Upper and lower case P and the comma are used when a pause is necessary.
   - The Pound sign (#) is used by some fax servers and is supported.
Common phone number symbols such as left and right parentheses and the dash are supported.

Spaces are supported.

Upper and lower case M used in front of a CallPilot mailbox number to designate the address as a CallPilot mailbox are supported.

The other fields are optional and are used to customize the fax or to direct CallPilot how to handle it. Three specific CallPilot fields and their parameters are:

- **ToName**: This is the fax recipient's name and can be up to 256 characters in length.
- **DelReceipt**: You can use this tag to receive a Delivery Receipt in the form of a CallPilot message in your CallPilot mailbox when the fax is delivered to the recipient. If the DelReceipt field is set to "1", then a delivery receipt will be generated. If DelReceipt is set to '0', a delivery receipt will not be generated for that recipient. If the DelReceipt field is empty or the field is not in Data.doc, then no delivery receipt will be generated.
- **DelType**: This field may be used to set a delivery priority for each recipient. If the DelType field is set to '0' or is left empty (or if it is not present in your Data.doc), the message will be tagged for Normal delivery. If DelType is set to "1", then the message will be tagged for Economy delivery. If DelType is set to "2", then the message will be tagged for Urgent delivery. Messages sent to non-CallPilot recipients with the Delivery Type set to Economy will be delivered on a schedule defined by the CallPilot server for Economy delivery. Messages sent to CallPilot mailboxes will not be affected by the Economy designation and will be sent as Normal messages. Transmission of messages tagged as Normal or Urgent will begin immediately. Urgent messages will display the Urgent icon when displayed from My CallPilot or a Desktop Messaging client and a voice prompt will identify the message as Urgent from the CallPilot telephone interface. Messages sent Urgent are treated as Normal when they are sent to non-CallPilot addresses.

4 Once the table has been updated, save all changes. You would normally supply a unique name for your data file here, but for the remainder of these procedures the name Data.doc will be used.

5 Close the document. The Data.doc file can now be used as a data source by MS Mail Merge.

**Accessing and modifying the example Main document**

The Sample.doc file is an example of a Microsoft Word main document.

1 From the \Program Files\Nortel Networks\CallPilot\nda directory, open Sample.doc in MS Word.

This document contains tagged fields corresponding to those in the example Data.doc file. You can use this as a template for your own fax or just to practise with. If you modified the column header names in Data.doc, you will have to modify them in your main document as well.
First page

The first page of the main document is a special page and does not become part of the final fax. Sample.doc is installed with the first page setup correctly.

The purpose of this page is to provide a location to map information in the data source to each customized fax document. To signal CallPilot that this as a Fax Batch file and to prevent this page from becoming part of the fax, two special control codes must be present on the first page:

- $SOJ$ Start of Job. This control signal s the fax driver to start processing and can be placed anywhere on the first page.
- /zz Skip this page. This control can be placed anywhere on the first page and prevents the first page from becoming part of the fax message.

The CallPilot desktop software will retrieve the Fax Number from the first page of the document. Additionally, CallPilot desktop software will retrieve the Recipient Name, the Delivery Receipt and the Delivery Type, if they exist on the first page.

- /tp Fax Number. Used to address the fax message. This field is required.
- /dr Delivery Receipt. A Delivery Receipt can be turned on or off for each recipient. This field is optional.
- /tn Name of Recipient. This name is used to identify the record in the Nortel Fax Batch Status dialog if the fax number is either missing or invalid. This field is optional.
/dt Delivery Type. Used to mark messages for Normal, Economy or Urgent delivery. **This field is optional.**

To complete the page, the Fax Number column header (i.e. <<ToFax>>) must be inserted after the /tp control using the Mail Merge insert function. Likewise, the Delivery Receipt column header (i.e. <<DelReceipt>>) may be inserted after the /dr control, the Name of Recipient field (i.e. <<ToName>>) may be inserted after the /tn control and the Delivery Type field (i.e. <<DelType>>) may be inserted after the /dt control.

**Note: All Fax Batch controls are case sensitive.**

As an advanced fax addressing feature, users can also modify all data in a single column without actually modifying the data source file. For example, if an existing data source table contains fax numbers for a large number of recipients, but the external access number '9' is missing, this number can be added to all fax numbers by modifying the control on the first page of the document as follows:

/tp9<<ToFax>>

In this example, a '9' will be added to the beginning of each phone number during fax batch processing. The data source remains unchanged and could be used from a different location which does not require a '9' for external access.

**Second page**

Once the data source document and the first page of the main document have been created, you can begin to customize your fax. The fax must be equal to or less than 8.5 inches in width.

You can use all of the data source column header tags to customize the document. The
In this example, the document is customized for each recipient. Data source column headers are inserted into the document using the MS Word Mail Merge utility Insert function. After the main document has been customized, it is ready to be merged with the information in the Data.doc file. Consult your MS Word Mail Merge help for more details on inserting data source fields into the document.

Merging data from the Data Source into the Main Document

When you are ready to merge data from the data source file into your main document:

1. Start Mail Merge from the MS Word Tools menu. Depending on which version of MS Word you are using, Mail Merge will be under different menu headings.
2. Verify that Sample.doc is currently selected as the main document and that Data.doc is currently selected as the data source.
3. Select Merge to Printer and then select the Nortel Fax Batch driver from the Print dialog box that appears.

   Note: Ensure that MS Word is not set up to print pages in reverse order.
4 Click **OK** in the **Print** dialog box to initiate the batch fax process.

When the document is merged, data values from the data source file will be merged into the main document at the appropriate tag positions and a separate fax TIF file for each recipient is created. CallPilot desktop software will address and transfer the fax files to the server. The CallPilot server is responsible for actually sending the fax to the recipients.

Once the process starts, the Print Status dialog appears. The page number increments as each page is converted to a TIF file. Since the first page is skipped, this page is not included in the count. For example, if a three page fax is sent to 10 recipients, the dialog box will display "Printing page 1", "Printing page 2", and so on up to "Printing page 20." Only 20 pages are printed because the first page of each document is skipped.

Problems that occur while creating the fax images or with the fax addresses will be displayed in a separate Nortel Fax Batch Status dialog box such as:

![Nortel Fax Batch Status](image)

Problems such as a missing fax address or an unsupported fax address format are checked. However, problems such as a wrong fax number will not be identified, provided the number is in a valid format. A wrong fax number will however result in the sending of a non-Delivery receipt to the user's CallPilot mailbox by the CallPilot server.

When you click the OK button, the batch process ends and no faxes are sent. You must then fix the fax address(es) and resubmit the job.

If all faxes and addresses were created properly, a dialog appears while the faxes are being addressed and transferred to the CallPilot Server. It indicates the status of the batch job. If you press Cancel in this dialog box before the job is completed, another dialog box appears asking you confirm the cancellation. If you select Yes, all temporary files will be deleted and the process ends. However, all faxes that have already transferred to the CallPilot server will be sent.
If a problem occurs while transferring the fax, a dialog similar to the following appears:

![Dialog Box]

If you select Yes, an attempt is made to resend the fax to the server. If you select No, the current fax is skipped and processing begins on the next fax in the list. The fax that was skipped will not be sent. If you select Cancel, another dialog box appears asking you to confirm the cancellation. If you choose Yes, all temporary files will be deleted and the process ends. Any faxes that have already been transferred to the CallPilot server will be sent. If you choose No, the failure dialog box shown above will be displayed again, allowing you to make a different choice.

After all the faxes have been successfully transferred to the server, a dialog box will confirm this.
Using fax cover pages

Callpilot DM Internet clients can choose to include a cover page with their faxes. These pages are typically designed and managed by the server administrator. The user simply chooses the desired style of cover page (if more than one is available).

Cover pages generally include the following information:

**From Information:**
- Title
- Name
- Department
- Company
- Phone number
- Fax number

**To Information:**
- Title
- Name
- Department
- Company
- Phone number
- Fax number

- Number of Pages
- Sent Date & Time
- A Cover Sheet Memo section

Nortel Fax Printer Driver form

You can use the Nortel Fax Printer form to send a fax message using either a CallPilot Desktop messaging client (such as Netscape Messenger) or the QuickFax feature.

The QuickFax feature allows you to send a fax directly from the print dialog box. If you want to include a cover page, you must select this option.

If you choose to send your fax using a CallPilot Desktop Messaging client instead, the cover page option will not be available.

If you choose to send your fax to a specific destination (for example, a fax machine), the **Cover page** field becomes active and lets you browse for a cover page and/or select one from the drop-down list. You can then modify its contents. This provides functionality similar to the Custom form. (Refer to the following section for details.) You can also choose not to include a cover page by selecting the **No cover page** option from the **Use fax cover page** drop-down list.

You can also include a Subject line here. The Subject field information will however only be displayed in the e-mail portion of the fax. It will not be displayed on a hard copy of the fax.
Modify and Preview cover page

You can preview the current cover page and modify its contents by clicking the Modify button in the Nortel Fax Printer driver window.
Click on **Preview** to view the current state of the cover page.

![Cover Page Preview](image)

The first time you access this page, CallPilot Desktop Messaging will try to fill in the From section using information from the registry. Desktop Messaging will remember the data that you entered into this section and automatically complete those fields the next time you use this page. Although the From information is automatically populated from the registry, you can still change it.

In the **To** section, one field always will be read only - the Fax field. CallPilot will populate it using address information from the Fax Driver forms. The **Name** field is left empty for you to complete.

CallPilot Desktop Messaging computes the number of pages (including the cover page) and enters this information in the **Pages** field.

The **Sent** field uses the current time and date by default. This field is also editable.

The **Memo** section is populated from the Memo section of the Modify cover page form.

Note that the maximum length of all cover page fields except the Memo field is 30 characters. The maximum length of the Memo field is 2500 characters.
Addressing messages

To address a message from an address book

You can address a CallPilot message from the CallPilot Address Book on the server, or from the e-mail address book on your computer or on the server. Address CallPilot messages the same way as your e-mail messages.

- The CallPilot Address Book on the server is maintained by your organization, and contains the addresses of the CallPilot users and distribution lists that you are allowed to use. You cannot edit this list.
- If you maintain a personal address book of e-mail addresses, you can add CallPilot addresses to this list.

To add CallPilot addresses to your personal address book

If you have an e-mail personal address book on your computer, you can add CallPilot addresses and distribution lists to it. Add CallPilot addresses the same way as e-mail addresses. You may want to distinguish between CallPilot and e-mail addresses by adding CallPilot after the recipient's name.

To address a message manually

You can type an address directly into the To field of a new message.

Required format for a CallPilot E-mail address

If you choose to enter a CallPilot addresses in the E-mail field, it must be entered in the following format:

[CALLPILOT:XXXXYYYY@ZZZZ]

Where:
XXXX = SMTP/VPIM prefix
YYYY = CallPilot Mailbox number
ZZZZ = CallPilot Server FQDN (server and domain)

For example, suppose CallPilot server “na42349” in the domain “us.nortel.com” with VPIM/SMTP prefix “1952897” contains mailbox “7404”. Then the CallPilot address for that mailbox would be:

[CALLPILOT:19528977404@na42349.us.nortel.com]

Required format for Fax and Telephone Numbers

If you choose to enter a fax or telephone number in the contact field(s), it must be entered as an alphanumeric string. Pause (P p .) and octothorpe (#) characters are supported.

The required format is:

[CALLPILOT:XXXX@ZZZZ]
Where:
XXXX = Telephone or fax number
ZZZZ = CallPilot Server FQDN (server and domain)

Examples of valid fax and telephone number formats are:
[CALLPILOT:7404@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321,7404@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321p7404@na42349.us.nortel.com]
[CALLPILOT:(800) 921-1342#123123@na42349.us.nortel.com]
Changing your mailbox settings

To view or change your CallPilot access settings

Your administrator enters the default CallPilot access information for you. You can change these settings if required. Refer to the online Help in the CallPilot Player for detailed explanation.

1. On the CallPilot Player, select **View > Options**.
2. Click the **General** tab to display your current access settings.
   - Uncheck **Remember Password** if you are using a shared computer.
3. Make any changes required, then click **OK**.

To change your CallPilot password

This is the same password that you use from the telephone.

1. Repeat steps 1 and 2 above, then click **Change Password**.
2. In the **Old password** field, type your current password.
3. In the **New password** field, type your new password.
4. In the **Retype new** field, type your new password again.
5. Click **OK** to save the change.
6. Click **OK** to exit the General settings.
Changing audio settings

To change the audio device and volume

You can play and record your messages from your telephone or your computer.

1. On the CallPilot Player, select View > Options.
2. Click the Audio tab to display the current Audio settings.

3. In Device, click Telephone if you want to play and record your voice messages from your telephone. Make sure the correct telephone number appears. Or, click Computer if you want to play and record your voice messages through your computer’s speakers and microphone.

4. In Volume, check the two Volume check boxes if you want to coordinate your CallPilot volume settings with your computer’s speaker and microphone volumes.

5. If you want a reminder to check these settings before playing or recording voice messages, check Confirm settings...

6. Click OK.
Using My CallPilot

If the web-based resources of My CallPilot are available for your mailbox, your administrator will provide you with the URL. For more information on My CallPilot, refer to the *My CallPilot User Guide*.

To view or change your CallPilot feature settings

1. In My CallPilot, click the **CallPilot Features** tab.
2. Select any feature and make changes to your setup as required. Any changes you make to a feature go into effect immediately whether you use CallPilot from your computer or from your telephone.

To view user information

In My CallPilot, click the **Useful Information** tab to view online user information specific to your mailbox.